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Roadmap:
SansView is a new application provided to the community to generate feedback. It is part of a 
broader effort to provide analysis tools to the SANS community. In providing this application, we 
hope to learn about the analysis needs of our users. We are interested in suggestions in two 
areas: 

• Functionality: what functionality would you like to see in an analysis application for SANS
• Ease-of-use: how would you improve the user interface

The functionality provided by SansView will be incorporated in a more complete analysis 
application scheduled for late 2009. SansView will continue to be supported and updates will 
mostly focus on both feature adding and bug fixing. See our Mission page for more details on 
the plans for future developments. 

Features:
• Simultaneous fit of a number of different sets of SANS data with/without the constraints. 
• Loading and displaying 1D and 2D data in various formats. 
• 1D and 2D data fitting using Scipy (L-M algorithm) or Park (a MC fitting optimizer) fitting 
engine. 
• Support P(r) inversion (via. indirect Fourier transform).
• Supporting  polydispersity and /or orientational distribution for  virtually all built-in model 
functions.
• Supporting pinhole or slit smearing  for all the data  with dQ (or dQl , dQw) data given.
• Supporting various 2D averaging methods : Circular, Sectorslicer, Annulus, Boxsum, BoxQx and 
BoxQy. 
• Supporting a number of standard models  and model-independent functions including form 
factor and structure factor functions  and their multiplications. 
• Plug-in mechanism for data readers. 
• User sets Qrange (Qmin and Qmax) for both 1D and 2D data for fitting and modeling. 
• The user can toggle between a number of different scales on all plots. 

Installation and Usage:
Currently  the installer is supported only on the Windows : Windows XP (PC), Vista (PC), and 
VMware (with Windows XP) on Mac were tested.

Contact us:
You can visit the SansView web page at: http://danse.chem.utk.edu/sansview.html
Comments? Bugs? Requests? Write to us at sansdanse@gmail.com

New application for SANS oriented system modeling and data analysis.
Oct.  1, 2009: version 0.1 is released.

Introduction
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How to install

1. Go to our DANSE Small Angle Neutron Scattering Project web page, 
http://danse.chem.utk.edu/index.html
and clicking on the “SansView 1.0”  will point to the release page 
where the windows installer can be downloaded.
Also, SansView tutorial can be
found at the same site.

2. Once “setupSansView-1.0.exe is downloaded, open the installer and 
follow the steps
as directed.
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How to install (continued)

3.  Once the SansView is installed, some sample 1D and 2D data can be 
found inside the “test” folder in the SansView-1.0 folder. This allows 
you to follow this tutorial  session without  having your own data 
set.

4.    The “plugins” folder also includes two example python files 
(testmodel_2.py and testmodel.py) for users to write their own 
model function. The file should be modified  and saved as a different 
file name before running the SansView application in order  for the 
functions to work. Modify the arrowed lines for your  own functions. 
Each file can hold one model function and more than one functions 
can be added in this way. See Appendix (page 31) or the example 
files in the plugins folder of the SansView folder for more details.
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I. Loading 1D and 2D data

I-1. Click on “Open” from the File menu 
(Fig. 1).

I-2. Locate your data file and 
click on the “Open” button 
(Fig. 2) 

(You can choose either 1D 
or 2D data in this way).
File extension  types that can 
be loaded are ASCII (text), 
CANSASxml, ASC (2D), sans, 
pr files.

The format of ASCII files 
should consist of  2 to 4 
columns of  Q, Intensity, (dI, 
dQ) in order where dQ is the 
instrumental uncertainty of 
Q and assumed to be 
originated by pinhole 
geometry.

Fig. 1

Fig. 2

I-3. Fig. 3 shows an example of 1 D and 2D 
plots of the loaded data.

1D data

2D data

Fig. 3
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II. Data fitting: 1D and 2D data; Single fit

II-1. Highlight the data in the plot by locating 
your mouse pointer to the plot symbols 
(Fig. 4).   (For  2D, right click on 2D data 
image plot.)

II-2. After right  clicking on the highlighted data,
you select  “Select data for fitting”  (Fig. 5).  
*Same for 2D from now.

Fig. 4

Fig. 5

II-3. Then, you have a fitting panel for the 
data you have chosen, on the left side
(Fig. 6). 

Fig. 6
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II. Data fitting : 1D and 2D data; Single fit (continued)

II-4. Select a model type of interest.
Right click on the arrow of the model
drop box, and choose the model 
function to fit(Fig. 7)

Fig. 7

Fig. 8

II-5. Play with the  parameter 
values so that you have 
a model calculated 
(green) curve as closed 
to the data  as possible 
(Fig. 8).
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II. Data fitting : 1D and 2D data; Single fit (continued)

Fig. 9

II-7. Adjust Q range of data 
for fitting (optional) 
(Fig. 9).

II-6. Select parameters to fit 
by clicking on the check 
box.  (Fig. 9).

II-10. Click on the “Fit” 
button (Fig. 9).

II-9. (Optional) You can switch  Simple Fit (Scipy ) or Complex Fit (Park) fitting 
engine by selecting  or deselecting “Park” in the Fitting menu (Fig. 10).

Fig. 10

8

*Note that the simple fit uses 
Levenberg–Marquardt 
algorithm, while the complex 
fit employs  MC to find a 
global minimum in chi2 space 
(longer run time).

II-8. Q range can be reset to 
the default values by 
clicking the reset button 
(Fig. 9).
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II. Data fitting : 1D and 2D data; Single fit (continued)

Fig. 11

II-10. If the fitting is successful, the fitting errors and chi2 will show up in the 
panel, and there will be nice consistency between the fitted curve and 
your data. ((Fig. 11).

II-11. If the fitting is not successful, you can play more with other model 
functions by choosing another model function (see Step II-4), or 
polydispersity parameters which will show up by clicking on 
“polydispersity” “yes” check box . (Fig. 11): For polydispersity parameters, 
good values of Nsigmas are between 3 and 5, where Nsigma refers to x-
distance of Gaussian distribution to be considered in the unit of sigma (See 
VII-10 for more details).
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II. Data fitting : 1D and 2D data; Single fit (continued)

Fig. 12

II-12. The fitting panel (and model panel) can be bookmarked by right-clicking 
on the panel and choosing bookmark in the popup menu. Once the panel 
is bookmarked, it can be recalled later by right-clicking on the panel and 
choosing the model name in the popup menu (Fig. 12). (Note that once 
the bookmark is recalled, you may loose the previous panel that you were 
working on unless it was already bookmarked.)

10
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II. Data fitting : 1D and 2D data; Single fit (continued)

Fig. 13

II-12. You can also try instrumental smearing by clicking on “On” button only if 
users provide dQ (, dQl, or dQw) in the forth column of their data (Fig. 13).

II-13. It is possible that the fitting results return with an error, especially when 
the model does not work with your data. This case, some functionalities of 
the panel may not work.  You can delete the fitting panel by clicking on the 
“x” mark beside of the panel title, and always open a new fitting panel by 
(Step II-2)  (Fig. 14).

Fig. 14
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II. Data fitting : 1D and 2D data; Single fit (continued)

II-14 A geometry of the cylinder model (2D) is shown in (Fig. 15).  See model 
functions in the Help menu (of the SansView Application) for other models. 

Fig. 15
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With 2D view, the orientational angle parameters will be 
displayed in the panel but used only for 2D calculations.
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III. Data fitting; Simultaneous fit

Fig. 16

III-1. The simultaneous fit uses the complex fit engine (Park).

III-2. Repeat Step II-1 to  II-6 to load at least two data set. Make sure that all 
adjustable parameters were checked including the parameters you want to 
constrain for the simultaneous fitting.

III-3. Open the simultaneous fit panel by clicking on “Simultaneous” in the 
Fitting menu (Fig. 16). The complex fitting engine will be set automatically.

III-4. Make sure that you know the model fitting function name labeled in your 
data plot (green curve): It is automatically named as M0, M1, M2,…)

Fig. 17
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III. Data fitting; Simultaneous fit (continued)

Fig. 18

III-5. Assuming your model describes your data well, in the Simultaneous Fit 
panel, click on the check box on your models corresponding to your data 
to fit or click on the Models check box to select all of them (Fig. 18).

III-6. Click on “Yes” to “ Add constraints”.
Select and type the constraints between two sets of fitting parmeters (Fig. 
18); eg., [M0][radius] =M1.radius , or [M0][radius] =2*M1.radius +M1.length
For more constraint box ,click on Add button. Or click on Remove button 
when it is not applicable.

III-7 Once all constraint setups are done, click on the Fit button to perform fit.
III-8. When the fitting is finished, the progress bar at the bottom of window will 

disappear (Fig.19).

Fig. 19
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III. Data fitting; Simultaneous fit (continued)

Fig. 18

III-9. Then, go back to the Fit panels of the data, and inspect the results (Fig. 20).
Note: Currently the errors of constrained parameters  will not be displayed 
well, but can be calculated by applying the equation of your constraints.

Fig. 20

III-10.  If the fitting results return with an error at the bottom of the SansView
window, close the Simultaneous Fit panel (in the same way shown in Step 
II-3), and repeat it again with different initial values of your parameters.

15
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IV. Model calculation

Fig. 22

IV-1. Click on the model in the “Model” menu bar (Fig. 21). It will open a 
model panel  as well as a plot panel (Fig. 22).

Fig. 21

IV-2. In the model panel, the model description and parameter inputs are 
provided. User can also change model function by selecting another from 
“Model” combo-box. Also, Q range and  the number of points of the 
calculation  can be 
adjusted by users
(Fig.22).
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IV. Model calculation (continued)

Fig. 23

IV-3. 2D model plot panel can be open by clicking on the “View 2D” button, 
and it will automatically updated afterward together with 1D plot as the 
input values are changed (Fig. 23).

IV-4. User can reset the model panel by selecting  a new model from the 
“Model” menu, and also can delete any control panel by clicking on “x” 
mark  beside of the panel name at the top right side corner. By clicking the 
Save button, the panel also can be saved and open later from the Fitting 
menu in the menu bar or by right-clicking and selecting it from the panel.

17



V-1. Once user loaded a 2D data or 2D model plot panel, 2D averaging is ready 
to go.

V-2.  Locate the mouse pointer anywhere in the 2D image, and select one of 
averaging methods (Sector, Annulus, Boxsum or Box average) by right-
click-holding the mouse and by locating the pointer.

V-3. Use your mouse to hold and to drag the small cursor in the line to 
perform an average the area between lines or inside lines (except the 
circular average).  Depending on the kinds of averaging features, the 
cursor movement is restricted to fit the geometry of the area to perform 
the averaging.

V-4. In some case, the error may interrupt to see the pattern of the averaged 
1D plot. Right-click on the highlighted 1D plot and choose “hide error 
bars”.
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V. 2D averaging

Fig. 24

Fig. 25

Before hiding error bars After hiding error bars
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V-5. Some screen shots below show the shape of averaging area that we 
support.

Sector average                  Annulus average           Box average (Qx or Qy)
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V. 2D average (continued)

Fig. 26

Boxsum (Integration over the area) Circular average for whole area
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VI-1. Currently saving an image or a plot panel is supported in png format. 
Right-clicking on anywhere inside 1D and 2D plot will bring the context 
menu box. Select “Save image”, “Print image”, or “Print Preview” of 
interest (Fig. 27).

VI-2.  1 D data in the plot can be saved in the formats of txt and CanSAS xml. 
Move mouse to the data points to highlight the symbols. Then, right-click 
on the highlighted data points. In the context menu, select “save points” 
(Fig. 28).
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VI. Save data and print images and plots

Fig. 27

Fig. 28
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VII. Pr inversion
21

Pr inversion is based on P. Moore, J. Appl. Cryst. (1980) 13, 168-175.
This calculation method is available in a stand alone application (PrView).  
Please see details at 
http://danse.chem.utk.edu/downloads/PrView0.2_tutorial.pdf
or http://danse.chem.utk.edu/prview.html.

In this tutorial, we show how to switch between Fitting (or model 
calculations) and Pr inversion.

VII-1. Choose ‘Pr inversion’ from ‘Perspective’ in the menu bar (cf. , choose 
‘Fitting’ to go back to model fitting panels).

VII-2.  If you have a data plot open, locate your mouse to the plot to 
highlight (yellow). On right-clicking, choose  ‘compute P(r)’ to load the data 
for Pr inversion.  Once the data loaded for Pr inversion, the data file name 
will be displayed in the text box named ‘Data’.  If you don’t have  data 
open, follow the steps in page 5 (Chapter I) to open your data first.

Fig. 29

Fig. 30

http://danse.chem.utk.edu/downloads/PrView0.2_tutorial.pdf
http://danse.chem.utk.edu/prview.html
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VII. Pr inversion (continued)
22

VII-3. Background estimate:  By checking the background estimate box, you 
can let the application fit a constant background value for your I(q) data.

VII-6. Suggested values: Estimates for the number of terms and the 
regularization constant are computed when the maximum distance or Q 
range is changed. When an estimate is available, a button with the value 
will be enabled. Click the button to accept the value.

VII-4. Slit smearing:  By typing slit height and/or width (in 1/A), you can 
include the smearing effect to the calculations.  When smearing included, 
both of the results with and without the smearing effect will be displayed.

VII-5. Q range:  Q range for  the I(q) may be specify in the Q min and Q max 
text boxes.

VII-7. Input parameters:
1) number of terms: number of 
terms in the expansion.
2) Regularization constant:  
parameter of the regularization 
term.
3) Max distance: maxmum
distance in the any two points in 
the system. 

Fig. 31

Fig. 32
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VII. Pr inversion (continued)
23

VII-8. Output parameters: Several output parameters are provided as 
figures of merit of the inversion process.
1) Rg and I(Q=0) are computed from the P(r) distribution.
2) Positive fraction: The fraction of the integral of the absolute value of p(r) 
that is positive.
3) 1-sigma positive fraction: The fraction of the integral of the absolute 
value of p(r) that is least one standard deviation above zero.
4) Oscillations: The oscillation parameter is defined as

integral(dp(r)/dp)^2/integral((p(r))^2)dr
Its value is 1.1 for a spherical system.

VII-9. Buttons:
1) Save: To save the information 
and results in the panel into a 
file so that later it can be 
reloaded.
2) Reset: To reset the panel to 
the default.
3) Compute: To perform the Pr 
calculations.

VII-11. Results: Once the p(r) distribution has be computed, the I(Q) 
corresponding to the Fourier transform of that distribution is shown and 
compared to the input data. 

VII-10. P(r) plot: Right clicking on the highlighted data points by locating 
mouse pointer to the data points in the P(r) plot panel, will provides a 
popup (context) menu. Then,
1) another set of P(r) data can be added into the plot by selecting ‘Add P(r) 

data’ from the menu
2) the number of the calculation points can be changed by selecting 

‘Change number of P(r) points’ from the menu
3) scaling and normalization can be also done by choosing a proper menu 

in the same way.

Fig. 33
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VII. Pr inversion (continued)
24

VII-12. Explore Dmax: Maximum distance  (Dmax) can be examined by 
clicking the ‘Explore’ button next to the Max distance input box. New popup 
window will be open displaying Chi^2 vs. Dmax as defaults.  Exploring  Dmax
with other parameter spaces can be done by choosing the parameter in the 
combobox named ‘Select a dependent variable’ at the top of the window.

Fig. 34



VII-1. Change scales or toggle Linear/ Log.
Right-click on 1D, 2D plot. Select “Change scale” or “Toggle Linear/Log 
scale” (Fig. 35). 

VII-2.  Close an open plot panels: All plot panels can be closed by clicking on 
the “x” mark at the top of window. In order to bring that panel back, go 
to the menu bar and select the panel to open under “Plot” menu (Fig. 
36).

DANSE/SANS Group 
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VIII. Miscellaneous

Fig. 35

Fig. 36
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VII-3. Your workspace can be re-arranged by clicking on and dragging the title 
bar outside or back to inside of the SansView interface (Fig. 37). 
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VIII. Miscellaneous (Continued)

VII-4. Changing color map of a 2D image (Fig. 38);
Open the context menu by right-clicking on the 
image plot. Select “Edit detector parameters “. 
Type integer numbers (not zero”) in the box.
If no number (no space) is entered, the image 
will be displayed in the default color depth.  A 
different color map can be selected by 
choosing one from the combobox named 
Cmap. This feature is one time feature, which 
means it will not be updated when updating or 
change the image plot. Note: This feature is 
still under construction, so use it with care. 
(Fig. 38).

Fig.37

Fig.38
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VII-5. Zooming: 1D data plot  can be zoomed out and in:
A) for both x- and y-axis; one-click in the plot panel , locate your pointer 

inside the axes then rotate the roller at the center of your mouse to zoom 
in and out (Fig. 39).
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VIII. Miscellaneous (Continued)

VII-7. The data points or curve can also be dragged around by click-and-
holding within the plot range.

Fig.39

27

B) x- or y- axis separately; one-click in the plot panel , locate your 
pointer  (black arrows in Fig. 39) somewhere between the axis line 
and label, and  use the mouse roller to zoom in and out the axis as 
desired.
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VIII. Miscellaneous (Continued)

VII-5. Some Helps and tips are available within the SansView application. 
Select “Fitting help” or others in the “Help” menu. This will provide you 
instant help (Fig. 40). 

VII-6. Simple tips and information will be displayed at the bottom line of the 
application whenever it is necessary (Fig. 41). 

Fig.40

Fig.41
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VII-7. Loadable data formats:
A) 1D data:

a) File extensions that can be loaded:  .txt, .dat, .abs, .xml, or w/o 
extension.
b) 2 to 4 columns of data are required in order of Q, I, (dI, dQ ).
c) The meta data (header) will be ignored unless in a standard xml 
format.

B) 2D data:
a) File extensions that can be loaded:  .ASC,  .sans 
b) 2D ASCII file should be from NIST IgorPro SANS reduction 
package and saved to the detector coordinates.

C) Examples  of data files are available in “test” folder inside the SansView-
1.0 folder (See page 4 and Appendix: User model documentation 
on page 27 -29).

VII-8.  Supporting model functions: The descriptions are available in the help 
menu.
A)  Shape models (form factors): sphere, cylinder, coreshell cylinder, 
coreshell sphere, ellipsoid, elliptical cylinder, and many more.
B) Shape independent models: DAB, BEPolyelectrolyte, Guinier, Debye, 
Porod, line, number density fractal, Lorentz, power law,  Teubner Strey.
C) Structure factors: square well, hardsphere, stickyHS, HayterMSA.
D) Customized models: Users can define their own model functions by 
modifying an example pyhton file in the “plugins” folder inside of the 
SansView-1.0 folder. See Appendix or the example files in the plugins
folder.
E) P(Q)*S(Q): Form factor times structure factor  supports for some shape 
based models (with 4 structure factors above). For cylinder and ellipsoid 
based models, the 2nd virial coefficient will be calculated automatically and  
applied to the structure factors.

VII-9.  Instrumental smearing is supported in fitting when your data includes 
dQ in its forth column.
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VIII. Miscellaneous (Continued)
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VII-10.  Polydispersity (1D and 2D) and orientational distribution (2D only) can 
be taken account for modeling and fitting. 
A) We use the Gaussian distribution function  (where width =Sigma (STD),  
Npts = number of points over the distribution, Nsigma = number * sigma 
(distance from the center to be covered)). Good values for Npts and 
Nsigma may be 7 to 21 and 2.5 to 3, respectively. 
B) Using a customized model:
Users can make two columns of a distribution function, and open the 
functional data file from a fitting panel  with polydispersity ON. The file 
should includes two columns of data where the first column is consistent 
with the values of the parameter and the 2nd column is for weighting 
factors. (Note that this user data will override the corresponding 
parameter value (eg., radius)  so that the parameter will become no longer 
fittable.)
An example of the user function is; 

radian       weight
0.707 0.4
1.14 1
1.414 0.1

VII-11. Customized models: Users  can define their own model function in the 
plugin folder of  the sansview folder. Take a look and modify the sample 
file  in the folder, or create a new one. Then the model function will be 
show up under “Customized model” menu in the menu bar. See Appendix 
(page 31) or the example files in the plugins folder of SansView folder for 
more details.

DANSE/SANS Group 
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VIII. Miscellaneous (Continued)
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IX. Appendix
31

User Model Documentation

SansView has a plug-in mechanism that allows users to write their own models in 
python. Each user model is placed in the plugins folder of the SansView installation. 
For instance, on the default Windows installation, the user model files will be placed 
in 
C:\Program Files\SansView-[version]\plugins

Note that the user may thus define any number of such special models. The content 
of each model plugin is the following:

"""
Test plug-in model

"""
from sans.models.pluginmodel import Model1DPlugin

import math

# ALL Your models MUST HAVE the class name Model as listed below (i.e.  
#DO NOT MODIFY this next line). 

# The unique name that appears in the menu for each of your models comes  
#next (Name of the model)
class Model(Model1DPlugin):

""" Class that evaluates a user model. 
"""
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VIII. Appendix (Continued)
32

## Name of the model -- this is where you put the uniqe name   

##for the model that will appear in the menu
name = "A+Bcos(2x)+Csin(2x)"

def __init__(self):
""" Initialization """
Model1DPlugin.__init__(self, name= self.name)

## Parameters definition and defaults
self.params = {}
self.params['A'] = 1.0
self.params['B'] = 1.0
self.params['C'] = 10.0

## Parameter details [units, minimum value, maximum value]
self.details = {}
self.details['A'] = ['', -1e16, 1e16]
self.details['B'] = ['', -1e16, 1e16]
self.details['C'] = ['', -1e16, 1e16]
self.description = "F(x)=A+Bcos(2x)+Csin(2x) "

def function(self, x = 0.0):
""" Evaluate the model

@param x: input x
@return: function value

"""
# For convenience, use local variables for the parameters
A = self.params['A']
B = self.params['B']
C = self.params['C']

return A+B*math.cos(2.0*x)+C*math.sin(2.0*x)



Notice the use of the math module in the function definition. The 
functions available through python's math module are documented on the 
python web site. Any number of user models can be defined at one time. 
They will automatically appear in SansView in the Model menu, under 
"Customized Models". 

The user models in the current version of SansView have a number of 
limitations:

1) SansView has to be restarted in order to see a new model appear in the 
Model menu. Similarly, any change in the model will require restarting 
SansView to be effective. Work is currently planned to allow live changes 
of the models.

2) Polydispersity is not currently available for user models. This feature is 
currently under development.

3) Since they are coded in python, user models can be slower to use. 
Contact the DANSE team if you would like to incorporate your model in 
the DANSE framework. The DANSE team will be able to port your model to 
a faster implementation.
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VIII. Appendix (Continued)

http://python.org/doc/2.5.2/lib/module-math.html

